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The questions in this section were designed to help familiarize you with the WRA Toolbar and 
address any questions you might have. If you have a question that is not addressed here, please 
contact us by visiting support at http://www.wra.org/toolbarhelp.  
 
 
Installation 
 
I’ve downloaded the Toolbar, but it doesn’t show up when I open Internet Explorer? 
Once you download the toolbar, you may need to go to the View menu in Internet Explorer and 
select Toolbars. Make sure WRA Toolbar is checked.  
 
Can I uninstall the Toolbar? 
Yes. Uninstalling is as easy as installing. From the WRA dropdown, select Help and click 
Uninstall.  
 
When I download the Toolbar, where is it stored on my computer? 
WRA Toolbar can be found at c:\\program files\WRAToolbar. 
 
General 
 
How do I get the latest update of the Toolbar? 
Auto update is one of the technical features of this toolbar. When online you may see a box 
informing you that there is a newer version available. You will be asked to click yes to instantly 
update to the latest version. You can also update from the WRA dropdown list. Just select Help 
and click Update Toolbar. Note: The latest version is also available on the Web site at 
www.wra.org\toolbar.  
 
Where’s the Zoom Tool, and how do I use it?  
If Zoom In and Zoom Out are not available on your toolbar, go to the WRA Dropdown and 
select Options. Next click in the box next to Zoom In and Zoom Out. A check will appear in the 
box. Click Save Toolbar Configuration to exit Options. These tools will now be available on the 
Toolbar. Please note if you plan to use the zoom tool, be sure to select both the Zoom In and 
Zoom Out options otherwise you will not be able to reverse their operation. 
 
What is the My WRA icon?  
One click on the My WRA icon allows you to view your own personal homepage at WRA.org. 
Access WRA account information, membership data, referrals list, favorite links and more. 
 

 



What is the WhiteList Editor? 
The WhiteList Editor allows pop-ups on select Web sites.  
 
Can I add and remove sites in the WhiteList Editor?  
Yes. From the WRA dropdown, select WhiteList Editor. In the box at the bottom of the screen, 
type the URL at which you wish to allow pop-ups, and click Add. To remove a site, highlight the 
site you wish to remove and click Remove. 
 
Can I turn the pop-up blocker off? 
Yes. The pop-up blocker is turned on by default. To turn it off, simply click the pop-up blocker 
button on the toolbar. This button shows a tally of the number of pop-ups blocked since 
installation. When the pop-up blocker is on, the button will be a lighter shade of gray. If you do not 
see this icon, make sure you have it set to display from the options page. To access the options 
page, click the checkmark icon. 
 
I have the pop-up blocker turned on and I am still receiving pop-ups. Why? 
First check to make sure the pop-up blocker is really turned on. If it is turned on, you will see a 
counter that indicates the number of pop-ups blocked. If the pop-up blocker says "Site Pop-ups 
Allowed", it is turned off and you will need to turn it on by pressing that icon. Second, check the 
white list editor. By default, there are a number of Web sites that can display pop-ups that are 
listed in your white list editor. If there is a site you do not want on the list, you must remove it from 
the list.  
 
Do I need to be online to use the WRA Toolbar? 
Though the toolbar will appear in Internet Explorer if you are not online, you need to be online to 
access many of the features such as the Mortgage Calculator, Find a REALTOR® database, 
maps and phone book. 
 
I am getting compatibility errors when I open PDF files. How do I fix this problem? 
You may receive an error message when closing an Internet Explorer window with a partially 
loaded PDF document. This error typically occurs unexpectedly and forces IE to shut down and 
appears in one of two ways.  
 
"Internet Explorer has encountered a problem with an add-on and need to close. The following 
add-on was running when this problem occured: File: pdf.ocx; Company Name: Adobe Systems, 
Incorporated; Description: Adobe Acrobat Control for ActiveX".  
 
After the above message, Windows may show error message box:  
"iexplore.exe - Application Error. The instruction at "0x043cf5db" referenced memory at 
"0x00000000". The memory could not be "read". Click on OK to terminate the program. Click on 
CANCEL to debug the program". 
 
This errors occurs on different versions of Windows and Internet Explorer and happens due to 
incompatibility issues between Adobe’s ActiveX controls in Internet Explorer (pdf.ocx ) and third 
party plug-ins, such as the WRA Toolbar.  
 
To fix this problem, you will need to tell Adobe Acrobat to open PDF documents in Adobe Acrobat 
instead of Internet Explorer; thus, bypassing the controls altogether. To make this change, please 
perform the following steps: 
 
Acrobat 5.0 

1. Drop down the Edit menu. 
2. Select Preferences.  
3. Select General Options. 
4. Select Options (this is not the same step as above) 
5. Deselect “Display PDF in Browser” by uncheckmarking the appropriate box. 



6. PDF files that are downloaded will now open in Adobe Acrobat instead of Internet 
Explorer. Depending on your version of IE, you may also get a dialog box when you 
download a PDF file asking you whether you want to open or save the document. This is 
normal. 

 
Acrobat 6.0 & 7.0 
 

1. Drop down the Edit menu. 
2. Select Preferences. 
3. Select Internet. 
4. Deselect “Display PDF in Browser” by uncheckmarking the appropriate box. 
5. PDF files that are downloaded will now open in Adobe Acrobat instead of Internet 

Explorer. Depending on your version of IE, you may also get a dialog box when you 
download a PDF file asking you whether you want to open or save the document. 
This is normal. 

 
Please note: if you do not wish to change your settings in Adobe Acrobat, you will need to 
uninstall the toolbar. For additional instructions, please visit the Adobe Web site and reference 
the following white paper.   
 
http://www.adobe.com/support/techdocs/315029.html 
 
How do I determine which version of the Toolbar I am using? 
To determine the version of the WRA Toolbar you are using, drop down the WRA menu (the 
house icon), select help and then About WRA Toolbar.  
  
I have Windows 98. The Toolbar does not display in Internet Explorer. Why? 
The WRA Toolbar is not compatible with Windows 98. You must have Windows XP to display the 
Toolbar.  
  
Will there be a Mozilla Firefox version of the WRA Toolbar? 
A WRA Toolbar for Mozilla Firefox is scheduled for delivery in early 2006. 
  
Will there be a version of the Toolbar for Netscape Navigator? 
This initiative is not yet underway. Please check back for a release schedule for this browser. 
  
How do I suggest a new feature? 
Your feedback is important to us. You can suggest a feature by emailing our staff at 
toolbar@wra.org  
  
Configuration 
 
How do I customize the Toolbar? 
Click the Checkmark icon on the toolbar or from the WRA dropdown select Options. You can 
specify which features you want in the toolbar by “checkmarking”and “uncheckmarking” options. If 
the box is checked, it will appear on the toolbar. You can remove icons in the same way. Click 
Save Toolbar Configuration at the bottom of the page to exit Options. 
 
Can I remove the button names to save space on the toolbar? 
Yes. To remove the descriptive text next to each button, click the options icon (checkmark icon) 
and uncheck the show descriptive text feature. This allows you to show more buttons on the 
toolbar. Click Save Toolbar Configuration at the bottom of the page to exit Options 
 



Searching 
 
How do I use the search function? 
Select the search engine/site you wish to use from the Search dropdown list. Type in the search 
word(s). Hit enter and view the results. 
 
How can I change the default search site? 
Each time you select a site from the Search dropdown list, it becomes the default search site. 
 
How do I search by MLS ID?  
Click on the Search dropdown and select Search MLS ID. Type in the MLS ID number and hit 
enter to search REALTOR.com. There may be multiple matches as the site searches properties 
nationwide. 
 
How do I search for something in a past issue of Wisconsin Real Estate Magazine?  
From the Search dropdown list, select Wisconsin Real Estate Magazine (WREM). Type in the 
search word(s) and hit enter. You will see a list of possible matches from past issues of both 
Wisconsin Real Estate Magazine and Wisconsin REALTOR®. 
 
What does the highlight button do? 
This feature helps you find matching words on a page once a search is performed. For example, 
if you perform a search on the word “dog”, the word “dog” will be highlighted in yellow anywhere it 
appears on the page. When searching on multiple words, each word will be highlighted in a 
different color.  
  
What is AutoComplete? 
When entering a search term, AutoComplete will attempt to match the word you are typing to 
save you from reentering an entire word. If AutoComplete fills in the correct word(s) for your 
search, hit enter to perform the search. If AutoComplete fills in the incorrect word(s), continue 
typing your desired search word(s). This is a default setting. To turn AutoComplete off, click the 
options icon (checkmark icon) and uncheck AutoComplete. Click Save Toolbar 
Configuration at the bottom of the page to exit Options. 
  
What is drop-down search history? 
If you have already performed a search, you will find those terms in the drop-down menu of the 
search bar. This feature is turned on by default. You can choose to turn this feature off in the 
options page. You can also choose to automatically run a search when you select from the 
search history. If you uncheck this feature, you will need to hit enter after selecting a search from 
the dropdown search history. 
 
What does the search drag feature do? 
This powerful feature allows you to highlight a word on a Web page and drag it into the search 
box. To use this feature, highlight and select the word(s) you wish to search and drag to the 
search box with your mouse. The toolbar will then automatically execute that search. This 
timesaving feature is turned on by default. You can turn it off in Options (checkmark icon). 
  
How do I clear my search history? 
To clear your search history click the WRA dropdown menu (house icon) and click clear search 
history. This will remove all previously executed searches from the search dropdown. If you do 
not want to have the toolbar track search history, you can turn this feature off within Options 
(checkmark icon) 
 
How does the Show Word-Find function work? 
After performing a search, the Show word-find button will be added at the right side of the toolbar. 
You can click the button to click through the search word matches on the page. There will be a 
button for each search word entered. This feature is turned off by default. To turn it on, go to 



Options (checkmark icon) and check the Show word-find button. Click Save Toolbar 
Configuration at the bottom of the page to exit Options. 
Search tip: If you want to search on a phrase like “Green Bay Packers” you must put it in quotes 
for it to function as a single search item. If it is not in quotes, you will get search results for each 
individual word. You will also have a show word-find button for each word. 
 
Mortgage Calculator 
 
When I click the tables and graphs tabs it does nothing. Why? 
You must first enter data in the Inputs tab to view amortization tables and graphs. The tables and 
graphs will automatically change when changes are made in the Inputs tab. 
         
How do I check the current mortgage rates from the Inputs and Affordability tab? 
Click the check rates button to see the current national average. 
  
Can I download the amortization table? 
Yes. From the tables tab, click the download to excel button at the top of the page to download 
the amortization table in comma-delimited format.  
          
How do I print the entire amortization table? 
From the tables tab, click the Show printer friendly page button at the top of the page. Then 
click the Send to printer icon at the top of the printer friendly page to print the table.  
           
Can I download the bar and curve charts from the tables tab? 
Yes. You can either click the download image button at the top of the page to download the 
graphic in GIF format or hold your mouse over the live graph and right click. Select save picture 
as to save to a file on your computer. 
  
On the graphs tab, what do the numbers represent on the left hand side? 
These numbers represent how much you will pay a year for your home. The green bar represents 
the portion of your payment applied to principal and the blue bar represents the portion of your 
payment applied to interest. 
  
On the Affordability Tab, how do I calculate my net yearly income and monthly debt? 
You can calculate these inputs using the embedded worksheets. Simply click worksheet and 
follow the instructions to calculate your exact income and debt. 
  
How is affordability calculated? 
The affordability tool is for reference purposes only. Please consult your lending institution on 
your particular situation. Affordability in this calculation is determined by subtracting your total 
expenses from your total net income, then considering the 28/36 rule. The 28/36 rule is one rule 
your lending institution may use to determine your eligibility for debt. It means that your monthly 
housing costs can't exceed 28 percent of your income and your total debt load can't exceed 36 
percent of your total monthly income. 


